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4 CONSTRUCTION OF A ROAD EMBANKMENT

The construction of an embankment on soft soil with a high groundwater level leads to an
increase in pore pressure. As a result of this undrained behaviour, the effective stress
remains low and intermediate consolidation periods have to be adopted in order to
construct the embankment safely. During consolidation the excess pore pressures
dissipate so that the soil can obtain the necessary shear strength to continue the
construction process.

This tutorial concerns the construction of a road embankment in which the mechanism
described above is analysed in detail. In the analysis three new calculation options are
introduced, namely a consolidation analysis, an updated mesh analysis and the
calculation of a safety factor by means of a safety analysis (phi/c-reduction).

4 m

3 m

3 m

12 m12 m 16 m

road embankment

peat

clay

dense sand

Figure 4.1 Situation of a road embankment on soft soil

Objectives:

• Consolidation analysis

• Modelling drains

• Change of permeability during consolidation

• Safety analysis (phi-c reduction)

• Updated mesh analysis (large deformations)

4.1 INPUT

Figure 4.1 shows a cross section of a road embankment. The embankment is 16.0 m
wide and 4.0 m high. The slopes have an inclination of 1:3. The problem is symmetric, so
only one half is modelled (in this case the right half is chosen). The embankment itself is
composed of loose sandy soil. The subsoil consists of 6.0 m of soft soil. The upper 3.0 m
is peat and the lower 3.0 m is clay. The phreatic level is located 1 m below the original
ground surface. Under the soft soil layers there is a dense sand layer of which 4.0 m are
considered in the model.

General settings

• Start the Input program and select Start a new project from the Quick select dialog
box.

• In the Project tabsheet of the Project properties window, enter an appropriate title.

• In the Model tabsheet make sure that Model is set to Plane strain and that Elements
is set to 15-Noded.

PLAXIS 2D 2017 | Tutorial Manual 61



TUTORIAL MANUAL

• Define the limits for the soil contour as xmin = 0.0, xmax = 60.0, ymin = −10.0 and
ymax = 4.0.

Definition of soil stratigraphy

The sub-soil layers are defined using a borehole. The embankment layers are defined in
the Structures mode. To define the soil stratigraphy:

Create a borehole at x = 0. The Modify soil layers window pops up.

• Define three soil layers as shown in Figure 4.2.

• The water level is located at y = -1 m. In the borehole column specify a value of -1 to
Head.

Open the Material sets window.

• Create soil material data sets according to Table 4.1 and assign them to the
corresponding layers in the borehole (Figure 4.2).

• Close the Modify soil layers window and proceed to the Structures mode to define
the embankment and drains.

Figure 4.2 Soil layer distribution

Hint: The initial void ratio (einit ) and the change in permeability (ck ) should be
defined to enable the modelling of a change in the permeability in a
consolidation analysis due to compression of the soil. This option is
recommended when using advanced models.
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Table 4.1 Material properties of the road embankment and subsoil

Parameter Name Embankment Sand Peat Clay Unit

General

Material model Model Hardening
soil

Hardening
soil

Soft soil Soft soil -

Type of material behaviour Type Drained Drained Undrained
(A)

Undrained
(A)

-

Soil unit weight above
phreatic level

γunsat 16 17 8 15 kN/m3

Soil unit weight below
phreatic level

γsat 19 20 12 18 kN/m3

Initial void ratio einit 0.5 0.5 2.0 1.0 -

Parameters

Secant stiffness in
standard drained triaxial
test

E ref
50 2.5· 104 3.5· 104 - - kN/m2

Tangent stiffness for
primary oedometer loading

E ref
oed 2.5· 104 3.5· 104 - - kN/m2

Unloading / reloading
stiffness

E ref
ur 7.5· 104 1.05· 105 - - kN/m2

Power for stress-level
dependency of stiffness

m 0.5 0.5 - - -

Modified compression
index

λ∗ - - 0.15 0.05 -

Modified swelling index κ∗ - - 0.03 0.01 -

Cohesion cref ' 1.0 0.0 2.0 1.0 kN/m2

Friction angle ϕ' 30 33 23 25 ◦

Dilatancy angle ψ 0.0 3.0 0 0 ◦

Advanced: Set to default Yes Yes Yes Yes Yes Yes

Groundwater

Data set - USDA USDA USDA USDA -

Model - Van
Genuchten

Van
Genuchten

Van
Genuchten

Van
Genuchten

-

Soil type - Loamy sand Sand Clay Clay -

> 2µm - 6.0 4.0 70.0 70.0 %
2µm − 50µm - 11.0 4.0 13.0 13.0 %
50µm − 2mm - 83.0 92.0 17.0 17.0 %
Use defaults - From data

set
From data
set

None From data
set

-

Horizontal permeability kx 3.499 7.128 0.1 0.04752 m/day

Vertical permeability ky 3.499 7.128 0.05 0.04752 m/day

Change in permeability ck 1· 1015 1· 1015 1.0 0.2 -

Interfaces

Interface strength − Rigid Rigid Rigid Rigid -

Strength reduction factor Rinter 1.0 1.0 1.0 1.0 -

Initial

K0 determination − Automatic Automatic Automatic Automatic -

Over-consolidation ratio OCR 1.0 1.0 1.0 1.0 -

Pre-overburden pressure POP 0.0 0.0 5.0 0.0 kN/m2
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4.1.1 DEFINITION OF EMBANKMENT AND DRAINS

The embankment and the drains are defined in the Structures mode. To define the
embankment layers:

Click the Create soil polygon button in the side toolbar and select the Create soil
polygon option in the appearing menu.

• Define the embankment in the draw area by clicking on (0.0 0.0), (0.0 4.0), (8.0 4.0)
and (20.0 0.0).

• Right-click the created polygon and assign the Embankment data set to the soil
polygon (Figure 4.3).

Figure 4.3 Assignment of a material dataset to a soil cluster in the draw area

To define the embankment construction level click the Cut polygon in the side
toolbar and define a cutting line by clicking on (0.0 2.0) and (14.0 2.0). The
embankment cluster is split into two sub-clusters.

In this project the effect of the drains on the consolidation time will be investigated by
comparing the results with a case without drains. Drains will only be active for the
calculation phases in the case with drains.

Click the Create hydraulic conditions button in the side toolbar and select the Create
drain option in the appearing menu (Figure 4.4).

Figure 4.4 The Create drain option in the Create hydraulic conditions menu

Drains are defined in the soft layers (clay and peat; y = 0.0 to y = -6.0). The distance
between two consecutive drains is 2 m. Considering the symmetry, the first drain is
located at 1 m distance from the model boundary. 10 drains will be created in total
(Figure 4.5). The head is defined at 0.0 m.
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Hint: The modelling of drains in a plane strain model actually involves the use of
an equivalent (lateral) permeability in the surrounding soil based on the drain
pattern. The latter has been omitted in this simplified example. More
information can be in found in literaturea.

a CUR (1997). Achtergronden bij numerieke modellering van geotechnische constructies, deel 2. CUR
191. Stichting CUR, Gouda
Indraratna, B.N., Redana, I.W., Salim, W. (2000), Predicted and observed behaviour of soft clay
foundations stabilised with vertical drains. Proc. GeoEng. 2000, Melbourne

Figure 4.5 Final geometry of the model

4.2 MESH GENERATION

• Proceed to the Mesh mode.

Generate the mesh. Use the default option for the Element distribution parameter
(Medium).

View the generated mesh. The resulting mesh is shown in Figure 4.6.

• Click on the Close tab to close the Output program.

Figure 4.6 The generated mesh

4.3 CALCULATIONS

The embankment construction is divided into two phases. After the first construction
phase a consolidation period of 30 days is introduced to allow the excess pore pressures
to dissipate. After the second construction phase another consolidation period is
introduced from which the final settlements may be determined. Hence, a total of four
calculation phases have to be defined besides the initial phase.
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Initial phase: Initial conditions

In the initial situation the embankment is not present.

• The remaining active geometry is horizontal with horizontal layers, so the K0
procedure can be used to calculate the initial stresses (Figure 4.7).

Figure 4.7 Configuration of the initial phase

The initial water pressures are fully hydrostatic and based on a general phreatic level
located at y = -1. Note that a phreatic level is automatically created at y = -1, according to
the value specified for Head in the borehole. In addition to the phreatic level, attention
must be paid to the boundary conditions for the consolidation analysis that will be
performed during the calculation process. Without giving any additional input, all
boundaries except for the bottom boundary are draining so that water can freely flow out
of these boundaries and excess pore pressures can dissipate. In the current situation,
however, the left vertical boundary must be closed because this is a line of symmetry, so
horizontal flow should not occur. The remaining boundaries are open because the excess
pore pressures can be dissipated through these boundaries. In order to define the
appropriate consolidation boundary conditions, follow these steps:

• In the Model explorer expand the Model conditions subtree.

• Expand the GroundwaterFlow subtree and set BoundaryXMin to Closed and
BoundaryYMin to Open (Figure 4.8).

Figure 4.8 The boundary conditions of the problem
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Consolidation analysis

A consolidation analysis introduces the dimension of time in the calculations. In order to
correctly perform a consolidation analysis a proper time step must be selected. The use
of time steps that are smaller than a critical minimum value can result in stress
oscillations.

The consolidation option in PLAXIS allows for a fully automatic time stepping procedure
that takes this critical time step into account. Within this procedure there are three main
possibilities:

Consolidate for a predefined period, including the effects of changes to the active
geometry (Staged construction).

Consolidate until all excess pore pressures in the geometry have reduced to a
predefined minimum value (Minimum excess pore pressure).

Consolidate until a specified degree of saturation is reached (Degree of
consolidation).

The first two possibilities will be used in this exercise. To define the calculation phases,
follow these steps:

Phase 1: The first calculation stage is a Consolidation analysis, Staged construction.

Add a new phase.

In the Phases window select the Consolidation option from the Calculation type
drop-down menu in the General subtree.

Make sure that the Staged construction option is selected for the Loading type.

• Enter a Time interval of 2 days. The default values of the remaining parameters will
be used.

• In the Staged construction mode activate the first part of the embankment (Figure
4.9).

Figure 4.9 Configuration of the phase 1

Phase 2: The second phase is also a Consolidation analysis, Staged construction. In
this phase no changes to the geometry are made as only a consolidation analysis to
ultimate time is required.

Add a new phase.

In the Phases window select the Consolidation option from the Calculation type
drop-down menu in the General subtree.

Make sure that the Staged construction option is selected for the Loading type.

• Enter a Time interval of 30 days. The default values of the remaining parameters will
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be used.

Phase 3: The third phase is once again a Consolidation analysis, Staged construction.

Add a new phase.

In the Phases window select the Consolidation option from the Calculation type
drop-down menu in the General subtree.

Make sure that the Staged construction option is selected for the Loading type.

• Enter a Time interval of 1 day. The default values of the remaining parameters will
be used.

• In the Staged construction mode activate the second part of the embankment
(Figure 4.10).

Figure 4.10 Configuration of the phase 3

Phase 4: The fourth phase is a Consolidation analysis to a minimum excess pore
pressure.

Add a new phase.

In the General subtree select the Consolidation as calculation type.

Select the Minimum excess pore pressure option in the Loading input drop-down
menu and accept the default value of 1 kN/m2 for the minimum pressure. The
default values of the remaining parameters will be used.

Before starting the calculation, click the Select points for curves button and select
the following points: As Point A, select the toe of the embankment. The second

point (Point B) will be used to plot the development (and decay) of excess pore pressures.
To this end, a point somewhere in the middle of the soft soil layers is needed, close to
(but not actually on) the left boundary. After selecting these points, start the calculation.

During a consolidation analysis the development of time can be viewed in the upper part
of the calculation info window (Figure 4.11).

In addition to the multipliers, a parameter Pexcess,max occurs, which indicates the current
maximum excess pore pressure. This parameter is of interest in the case of a Minimum
excess pore pressure consolidation analysis, where all pore pressures are specified to
reduce below a predefined value.
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Figure 4.11 Calculation progress displayed in the Active tasks window

4.4 RESULTS

After the calculation has finished, select the third phase and click the View
calculation results button. The Output window now shows the deformed mesh after

the undrained construction of the final part of the embankment (Figure 4.12). Considering
the results of the third phase, the deformed mesh shows the uplift of the embankment toe
and hinterland due to the undrained behaviour.

Figure 4.12 Deformed mesh after undrained construction of embankment (Phase 3)

• In the Deformations menu select the Incremental displacements→ |∆u|.
Select the Arrows option in the View menu or click the corresponding button in the
toolbar to display the results arrows.

On evaluating the total displacement increments, it can be seen that a failure mechanism
is developing (Figure 4.13).

• Click <Ctrl> + <7> to display the developed excess pore pressures (see Appendix C
of Reference Manual for more shortcuts). They can be displayed by selecting the
corresponding option in the side menu displayed as the Pore pressures option is
selected in the Stresses menu.
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Figure 4.13 Displacement increments after undrained construction of embankment

Click the Center principal directions. The principal directions of excess pressures
are displayed at the center of each soil element. The results are displayed in Figure
4.14. It is clear that the highest excess pore pressure occurs under the embankment
centre.

Figure 4.14 Excess pore pressures after undrained construction of embankment

• Select Phase 4 in the drop down menu.

Click the Contour lines button in the toolbar to display the results as contours.

Use the Draw scanline button or the corresponding option in the View menu to
define the position of the contour line labels.

Figure 4.15 Excess pore pressure contours after consolidation to Pexcess < 1.0 kN/m2

It can be seen that the settlement of the original soil surface and the embankment
increases considerably during the fourth phase. This is due to the dissipation of the
excess pore pressures (= consolidation), which causes further settlement of the soil.
Figure 4.15 shows the remaining excess pore pressure distribution after consolidation.
Check that the maximum value is below 1.0 kN/m2.

The Curves manager can be used to view the development, with time, of the excess pore
pressure under the embankment. In order to create such a curve, follow these steps:

Create a new curve.
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• For the x-axis, select the Project option from the drop-down menu and select Time
in the tree.

• For the y -axis select the point in the middle of the soft soil layers (Point B) from the
drop-down menu. In the tree select Stresses→ Pore pressure→ pexcess.

• Select the Invert sign option for y-axis. After clicking the OK button, a curve similar
to Figure 4.16 should appear.

Figure 4.16 Development of excess pore pressure under the embankment

Figure 4.16 clearly shows the four calculation phases. During the construction phases
the excess pore pressure increases with a small increase in time while during the
consolidation periods the excess pore pressure decreases with time. In fact,
consolidation already occurs during construction of the embankment, as this involves a
small time interval. From the curve it can be seen that more than 50 days are needed to
reach full consolidation.

• Save the chart before closing the Output program.

4.5 SAFETY ANALYSIS

In the design of an embankment it is important to consider not only the final stability, but
also the stability during the construction. It is clear from the output results that a failure
mechanism starts to develop after the second construction phase.

It is interesting to evaluate a global safety factor at this stage of the problem, and also for
other stages of construction.

In structural engineering, the safety factor is usually defined as the ratio of the collapse
load to the working load. For soil structures, however, this definition is not always useful.
For embankments, for example, most of the loading is caused by soil weight and an
increase in soil weight would not necessarily lead to collapse. Indeed, a slope of purely
frictional soil will not fail in a test in which the self weight of the soil is increased (like in a
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centrifuge test). A more appropriate definition of the factor of safety is therefore:

Safety factor = Smaximum available

Sneeded for equilibrium
(4.1)

Where S represents the shear strength. The ratio of the true strength to the computed
minimum strength required for equilibrium is the safety factor that is conventionally used
in soil mechanics. By introducing the standard Coulomb condition, the safety factor is
obtained:

Safety factor =
c − σn tanϕ

cr −σn tanϕr
(4.2)

Where c and ϕ are the input strength parameters and σn is the actual normal stress
component. The parameters cr and ϕr are reduced strength parameters that are just
large enough to maintain equilibrium. The principle described above is the basis of the
method of Safety that can be used in PLAXIS to calculate a global safety factor. In this
approach the cohesion and the tangent of the friction angle are reduced in the same
proportion:

c
cr

=
tanϕ
tanϕr

= ΣMsf (4.3)

The reduction of strength parameters is controlled by the total multiplier ΣMsf . This
parameter is increased in a step-by-step procedure until failure occurs. The safety factor
is then defined as the value of ΣMsf at failure, provided that at failure a more or less
constant value is obtained for a number of successive load steps.

The Safety calculation option is available in the Calculation type drop-down menu in the
General tabsheet. If the Safety option is selected the Loading input on the Parameters
tabsheet is automatically set to Incremental multipliers.

To calculate the global safety factor for the road embankment at different stages of
construction, follow these steps:

• Select Phase 1 in the Phases explorer.

Add a new calculation phase.

• Double-click on the new phase to open the Phases window.

• In the Phases window the selected phase is automatically selected in the Start from
phase drop-down menu.

In the General subtree, select Safety as calculation type.

The Incremental multipliers option is already selected in the Loading input box. The
first increment of the multiplier that controls the strength reduction process, Msf, is
set to 0.1.

Note that the Use pressures from the previous phase option in the Pore pressure
calculation type drop-down menu is automatically selected and grayed out indicating
that this option cannot be changed

• In order to exclude existing deformations from the resulting failure mechanism,
select the Reset displacements to zero option in the Deformation control parameters
subtree.

• In the Numerical control parameters subtree deselect Use default iter parameters
and set the number of Max steps to 50. The first safety calculation has now been
defined.
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• Follow the same steps to create new calculation phases that analyse the stability at
the end of each consolidation phase.

Hint: The default value of Max steps in a Safety calculation is 100. In contrast to
an Staged construction calculation, the specified number of steps is always
fully executed. In most Safety calculations, 100 steps are sufficient to arrive
at a state of failure. If not, the number of steps can be increased to a
maximum of 1000.

» For most Safety analyses Msf = 0.1 is an adequate first step to start up the
process. During the calculation process, the development of the total
multiplier for the strength reduction, ΣMsf , is automatically controlled by the
load advancement procedure.

Figure 4.17 Phases explorer displaying the Safety calculation phases

Evaluation of results

Additional displacements are generated during a Safety calculation. The total
displacements do not have a physical meaning, but the incremental displacements in the
final step (at failure) give an indication of the likely failure mechanism.

In order to view the mechanisms in the three different stages of the embankment
construction:

Select one of these phases and click the View calculation results button.

• From the Deformations menu select Incremental displacements→ |∆u|.
Change the presentation from Arrows to Shadings. The resulting plots give a good
impression of the failure mechanisms (Figure 4.18). The magnitude of the
displacement increments is not relevant.

The safety factor can be obtained from the Calculation info option of the Project menu.
The Multipliers tabsheet of the Calculation information window represents the actual
values of the load multipliers. The value of ΣMsf represents the safety factor, provided
that this value is indeed more or less constant during the previous few steps.

The best way to evaluate the safety factor, however, is to plot a curve in which the
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Figure 4.18 Shadings of the total displacement increments indicating the most applicable failure
mechanism of the embankment in the final stage

parameter ΣMsf is plotted against the displacements of a certain node. Although the
displacements are not relevant, they indicate whether or not a failure mechanism has
developed.

In order to evaluate the safety factors for the three situations in this way, follow these
steps:

• Click the Curves manager button in the toolbar.

• Click New in the Charts tabsheet.

• In the Curve generation window, select the embankment toe (Point A) for the x-axis.
Select Deformations→ Total displacements→ |u|.

• For the y -axis, select Project and then select Multipliers→ ΣMsf . The Safety
phases are considered in the chart.

• Right-click on the chart and select the Settings option in the appearing menu. The
Settings window pops up.

• In the tabsheet corresponding to the curve click the Phases button.

• In the Select phases window select Phase 5 (Figure 4.19).

Figure 4.19 The Select phases window

• Click OK to close the Select phases window.

• In the Settings window change the titles of the curve in the corresponding tabsheet.

• Click the Add curve button and select the Add from current project option in the
appearing menu. Define curves for phases 6, 7 and 8 by following the described
steps.

• In the Settings window click the Chart tab to open the corresponding tabsheet.
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• In the Chart tabsheet specify the chart name.

• Set the scaling of the x-axis to Manual and set the value of Maximum to 1 (Figure
4.20).

Figure 4.20 The Chart tabsheet in the Settings window

• Click Apply to update the chart according to the changes made and click OK to
close the Settings window.

• To modify the location of the legend right-click on the legend.

• In the appearing menu point at View and select the Legend in chart option (Figure
4.21).

Figure 4.21 Enabling legend in chart

• The legend can be relocated in the chart by dragging it. The plot is shown in Figure
4.22.

The maximum displacements plotted are not relevant. It can be seen that for all curves a
more or less constant value of ΣMsf is obtained. Hovering the mouse cursor over a point
on the curves, a box showing the exact value of ΣMsf can be obtained.
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Figure 4.22 Evaluation of safety factor

4.6 USING DRAINS

In this section the effect of the drains in the project will be investigated. Four new phases
will be introduced having the same properties as the first four consolidation phases. The
first of these new phases should start from the initial phase. The differences in the new
phases are:

• The drains should be active in all the new phases. Activate them in the Staged
construction mode.

• The Time interval in the first three of the consolidation phases (9 to 11) is 1 day. The
last phase is set to Minimum excess pore pressure and a value of 1.0 kN/m2 is
assigned to the minimum pressure (|P-stop|).

After the calculation is finished save the project, select the last phase and click the
View calculation results button. The Output window now shows the deformed mesh

after the drained construction of the final part of the embankment. In order to compare
the effect of the drains, the excess pore pressure dissipation in node B can be used.

Open the Curves manager.

• In the Chart tabsheet double click Chart 1 (pexcess of node B versus time). The chart
is displayed. Close the Curves manager.

• Double-click the curve in the legend at the right of the chart. The Settings window
pops up.

• Click the Add curve button and select the Add from current project option in the
appearing menu. The Curve generation window pops up.

• Select the Invert sign option for y-axis and click OK to accept the selected options.

• In the chart a new curve is added and a new tabsheet corresponding to it is opened
in the Settings window. Click the Phases button. From the displayed window select
the Initial phase and the last four phases (drains) and click OK.

• In the Settings window change the titles of the curves in the corresponding
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tabsheets.

• In the Chart tabsheet specify the chart name.

• Click Apply to preview the generated cure and click OK to close the Settings
window. The chart (Figure 4.23) gives a clear view of the effect of drains in the time
required for the excess pore pressures to dissipate.

Figure 4.23 Effect of drains

Hint: Instead of adding a new curve, the existing curve can be regenerated using
the corresponding button in the Curves settings window.

4.7 UPDATED MESH + UPDATED WATER PRESSURES ANALYSIS

As can be seen from the output of the Deformed mesh at the end of consolidation (stage
4), the embankment settles about one meter since the start of construction. Part of the
sand fill that was originally above the phreatic level will settle below the phreatic level.

As a result of buoyancy forces the effective weight of the soil that settles below the water
level will change, which leads to a reduction of the effective overburden in time. This
effect can be simulated in PLAXIS using the Updated mesh and Updated water pressures
options. For the road embankment the effect of using these options will be investigated.

• Select the initial phase in the Phases explorer.

Add a new calculation phase.

• Define the new phase in the same way as Phase 1. In the Deformation control
parameters subtree check the Updated mesh and Updated water pressures options.

• Define in the same way the other 3 phases.

When the calculation has finished, compare the settlements for the two different

PLAXIS 2D 2017 | Tutorial Manual 77



TUTORIAL MANUAL

calculation methods.

• In the Curve generation window select time for the x-axis and select the vertical
displacement (uy ) of the point in the middle of the soft soil layers (Point B) for the
y -axis.

• In this curve the results for Initial phase and phases from 1 to 4 will be considered.

• Add a new curve to the chart.

• In this curve the results for Initial phase and phases from 13 to 16 will be
considered. The resulting chart is shown in Figure 4.24.

Figure 4.24 Effect of Updated mesh and water pressures analysis on resulting settlements

In Figure 4.24 it can be seen that the settlements are less when the Updated mesh and
Updated water pressures options are used (red curve). This is partly because the
Updated mesh procedure includes second order deformation effects by which changes of
the geometry are taken into account, and partly because the Updated water pressures
procedure results in smaller effective weights of the embankment. This last effect is
caused by the buoyancy of the soil settling below the (constant) phreatic level. The use of
these procedures allows for a realistic analysis of settlements, taking into account the
positive effects of large deformations.
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